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The Energy Poverty and Equity Explorer: Technical User 
Guide 
 

The Canadian Urban Sustainability Practitioners’ (CUSP) Energy Poverty and Equity 
Explorer maps a set of indicators to help inform policy and programs concerned with home 
energy cost burden, efficiency and clean energy transition.  

This mapping tool was developed by CUSP with design and technical support from the 
Community Data Program team and customized data sets ordered from and created by 
Statistics Canada.  This tool was developed with funding from the Municipal Climate 
Innovation Program of the Federation of Canadian Municipalities (FCM)1 for CUSP’s Local 
Energy Access Programs (LEAP) project.  The LEAP project is a multi-city, multi-sector 
initiative led by CUSP to achieve deep emissions and energy poverty reductions through 
equitable clean energy program design and delivery.   Members of the CUSP network as 
well as of the Community Data Program have access to the larger data set behind this map, 
containing many more variables. 

 

 
 

 

 

  

                                                 
1 The preparation of the Energy Poverty and Equity Explorer was carried out with assistance from the Government of Canada 
and the Federation of Canadian Municipalities. Notwithstanding this support, any views expressed and insights developed 
using this tool are the personal views of the authors and users, and the Federation of Canadian Municipalities and the 
Government of Canada accept no responsibility for them. 

ABOUT CANADIAN URBAN SUSTAINABILITY PRACTITIONERS (CUSP) 

Launched in the spring of 2015, the CUSP network connects sustainability practitioners 
from Canada’s large and leading municipalities and provides added capacity to support 
their collective efforts and expand their reach and impact.   Combined, CUSP's 
seventeen member cities represent a population of 18 million, or one half of the 
country’s population and generate $1 Trillion, or 55% of the country’s GDP. 

www.cuspnetwork.ca 

http://www.cuspnetwork.ca/
http://www.communitydata.ca/
file:///C:/Users/Allison/AppData/Local/Microsoft/Windows/INetCache/Content.Outlook/U6IJHCWO/www.cuspnetwork.ca
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This User Guide explains what the Energy Poverty and Equity Explorer can do and how to 
use it.   

Users can navigate the Guide by clicking on Table of Contents items. 
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Geographic levels, navigation and searching 
 

 

GEOGRAPHIC LEVELS USED IN THE MAP 
 

Census Division 
Represents a county or region. Some metropolitan 
areas like Metro Vancouver, Toronto or Ottawa are 
Census Divisions. 
 
Technical Description – A group of neighbouring 
municipalities joined together for regional planning 
and managing common services, such as a County 
or Regional Municipality. 

 
 
 

Census Subdivision 
 
Most often corresponds to cities or towns. 
 
Technical Description - A lower tier or single tier 
municipality or an area that is deemed to be 
equivalent to a municipality for statistical 
reporting purposes. 
 
 

 
 
 

Census Tracts 
 
Roughly the size of a neighbourhood in cities, but 
its boundaries do not correspond to local 
neighbourhood names and places referred to 
familiarly by municipalities and residents. 
 
Technical Description - Located in and around 
large urban centres with an urban core population 
of 50,000 or more, and usually containing a 
population of 2,500 to 8,000 persons. 
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Level of disaggregation available in this tool: 
As a result of how the census is reported, more data is available in urban areas with larger 
populations.  As such, the Energy Poverty and Equity Explorer tool contains varying data by 
geographical level. Energy cost burden measures and other indicators are available at: 
 

• Census Division level for all of Canada  
• Census Subdivisions and Census Tracts in all major urban centres (or Census 

Metropolitan Areas). 
 

SEARCH TOOL 
 
The Search Tool allows users to find an 
area on the map using a street address, 
postal code or place name.   
 
When searching for a street address, an incorrect postal code may be displayed in the 
Search bar, but the correct Census Tract will be produced. 

 
ZOOM TOOL 
 
To navigate, users can grab the 
map and pan. Users can also 
zoom in and out of the map 
using the zoom tool at the bottom of the screen.  
 
Clicking on the zoom tool bar will make the map zoom to the selected geographic level. 

 
 
 
Clicking on the map will 
make the map zoom into 
that area and open a profile 
window displaying the value 
for the selected indicator. 

 
 
 
  



5 
 

 

CUSP PINS 
 

 
The CUSP pins indicate 
municipalities that are members of 
the CUSP network. Clicking on a 
CUSP pin will make the map zoom to 
that area and open the profile 
window displaying the value for the 
selected indicator. 
 
 

 
 
 

INFORMATION POP-UPS 
 
Clicking on a circled i will bring up useful information. The tool offers information pop-ups 
with definitions of indicators, a description of the geographic levels used and an explanation 
of the Cross-tabulation button. 
 
 

Indicator display and selection 
 

PROFILE WINDOW 
 

 
When an area is clicked, a profile window for that 
region opens, displaying the value of the indicator, as 
a proportion as well as the absolute count of persons 
or households being represented. 
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HOVERING OVER A REGION 
 
Hovering over an area will display the name of the 
geography, as well as the name and value of the selected 
indicator. 
 
 
 

INDICATOR SELECTION DROPDOWN LIST 
 

Users can display different indicators 
on the map by selecting from the 
dropdown list in the top left corner of 
the screen.  

 
 
 
The indicators are grouped into 
themes.   
 
Clicking on the circled i button will 
bring up a description of the indicator.  
 
 
 
 
 
 
 
 
 
 

 
 

 

COMING SOON 

Household-level indicators on commuting will be added to the Energy Poverty and 
Equity Explorer soon. In the meantime, the percentage of commuters driving a car is 
provided. However, unlike the other indicators, this indicator can not be cross-tabulated 
by households paying 6% or more of after-tax income on home energy (see Cross-
tabulating indicators). 
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THE ‘OTHER INDICATORS’ BUTTON 
 
Clicking on "Other indicators" opens a drop-
down display that provides the other indicator 
values and counts for the selected area. 
 
 
 
 
 
 

COMPARE WITH NEIGHBOURING 
CENSUS TRACTS  

 
When viewing indicators at the Census 
Tract level, the profile window will offer the 
option to "Compare with Neighbouring 
Census Tracts". Selecting this option opens 
a drop-down display that charts the current 
indicator value against that of other census 
tracts in the immediate vicinity. 
 
Hovering the mouse over the bars of the 
chart will highlight the selected Census 
Tract on the map. Clicking on a bar will 
select that area on the map, allowing users 
to view the area to which the census track 
number corresponds.  
 

 
 
 
It is also possible to download the data that make up the chart by selecting the ‘Download 
CSV’ link. 
 

 
  

A CSV file opened in Excel may be modified by Excel’s attempt at recognizing data types 
and formatting them.  Therefore, care should be taken when opening the CSV file in 
Excel in order to preserve the leading and trailing zeros in the names of Census Tracts. 
One way to do this in Excel is to ensure Excel is told not to detect data types by selecting 
Data →Get Data→From File→From Text/CSV, then selecting the file and under "Data 
Type Detection" checking "Do not detect data types". 
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COMPARE WITH CUSP AND BCMC MEMBERS  
 

When viewing data at the Census 
Subdivision level, the profile window will 
offer the option to "Compare with CUSP and 
BCMC Members". Selecting this option 
opens a drop-down display that charts the 
current indicator value against that of other 
cities that are members of the CUSP 
network or the Big City Mayors Caucus 
(BCMC). 
 
Clicking on a bar in the chart will select that 
city on the map.  
 
It is also possible to download the data that 
make up the chart by selecting the 
‘Download CSV’ link.  

 
 
 

Cross-tabulating indicators 
 
Most of the indicators can be cross-tabulated 
to select for households that are paying 6% or 
more of their after-tax income on home 
energy.    
 
For example, when displaying the Housing 
Condition indicator, the map shows the 
proportion of all dwellings requiring major 
repairs for the chosen geographic area. 
 
If the Cross-tabulated button is switched to ‘on’ position, 
the map will display the proportion of dwellings requiring 
major repairs for the subset of households that pay 6% of 
more of their after-tax income on home energy (in other 
words the # and % of households in ‘energy poverty’ AND in need of major repair). 

 
 

 

CUSP has chosen to cross-tabulate these 
indicators with a 6% energy cost burden 
threshold. The 6% threshold represents 
roughly twice the median home energy 
cost burden in Canada, highlighting 
households that face disproportionate 
home energy costs relative to their after-
tax income. 
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Ranking tool 
 
 
 
Users can open the ranking tool by clicking on 
the three lines in the top right corner of the 
screen (1). 
 
The ranking tool allows the user to rank 
different geographic areas within a Census 
Metropolitan Area (CMA) for each indicator in 
the map. 
 
After selecting an indicator (2), the user selects 
a province (3) and then the Census Metropolitan 
Area (4) they want to see the ranking of that 
indicator for. 
 
Users can rank the Census Subdivisions or 
Census Tracts within a CMA (5).  
 
Census Subdivisions are identified by 
recognizable names of cities, whereas Census 
Tracts are identified by number. Users should 
refer to the map in order to locate Census 
Tracts.  
 
The map will display the indicator selected in the 
ranking tool (2). 
 
The bar chart icon (6) can toggle the order of 
the rankings between ascending and 
descending. 
 
Users can click on a geography in the ranked list 
(7) to centre the map on that area. 
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Methodology notes 
 
The mapping tool has been made using data taken from the 2016 Census of Population. 
 
The universe of the map comprises all households with after-tax income and with non-zero 
home energy costs. Households with zero after-tax income or with zero home energy costs 
are not included in the data to more accurately represent home energy cost burdens for 
those who pay these costs. For example, rental households with electricity and heating 
costs included in their rent are not included in the data. As a result, some values may differ 
from similar indicators you will find in other Census data products, such as the Census 
Profile. 
 
Note that the 2016 Census does not have income and housing cost data for Reserves. In 
the Energy Poverty and Equity Explorer, Census Subdivisions that are Reserves display no 
data and the data for Census Divisions containing Reserves do not include these areas. This 
lack of data represents a substantial gap as research on housing condition, energy rates and 
access, and income levels indicate that the pervasiveness and extent of energy poverty in 
Indigenous communities is significant.  
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Technical development notes for the Energy Poverty 
and Equity Explorer  
 
The technical specifications of the mapping tool include four basic components. The first 
component is a Map of Canada, relying on Leaflet.js along with D3.js. A second component, 
the Base Map, is hosted and styled on Mapbox.com, using OpenStreetMap data offering 
features such as roadways, water bodies and institutional facilities. Accompanying the Map 
of Canada and Base Map is a Geographic Boundary File, relying on Statistics Canada’s 
cartographic boundary files for dissemination areas based on the 2016 Census. Finally, the 
User Interface has been built using jQuery, Bootstrap, CSS and HTML. 
 
The map has been built using data from a custom tabulation obtained in partnership with 
the Community Data Program. The full data tables, which are available to CUSP members 
and members of the Community Data Program, contain the following variables: 
 
• Selected housing characteristics, including structural type of dwelling, period of 

construction, housing condition, household size, housing affordability and core housing 
need. 

• Selected household statistics, including average and median home energy spending as 
% of after-tax household income, average and median home energy expenditures, 
average household size and average and median after-tax household income. 

• Home energy spending as % after-tax household income (thresholds) 
• Household home energy expenditures (presence or absence) 
• Low Income Status (LIM-AT) 
• After-tax household income groups 
• Housing tenure 
• Households where no person aged 18+ has full-time/full-year employment 
• Households with at least one person aged 25+ without certificate, diploma or degree 
• Households with at least one person aged 18+ who is Aboriginal identity 
• Households with at least one person aged 18+ who is a visible minority 
• Households with at least one person aged 18+ who is a recent immigrant (period of 

immigration 2011 to 2016) 
• Households with at least one person aged 18+ who speaks neither English nor French as 

the language spoken at home 
• Households with at least one person aged 65+  

 

https://communitydata.ca/
https://communitydata.ca/

